APPLICATIONS USING ARCVIEW 3.2

CHAPTER 12

The applications section includes four tasks. Task 1 uses DEM data for land surface mapping and analysis in ArcView. Task 2 performs a viewshed analysis. Tasks 3 and 4 deal with TINs: Task 3 builds and displays a TIN in ArcView, and Task 4 builds a TIN in ARC/INFO and derives a slope and aspect maps from the TIN. 

Task 1: Terrain Mapping and Analysis Using DEM

What you need: plne, an elevation grid; streams.shp, a stream shapefile.


The elevation grid plne is imported from a USGS 7.5-minute DEM. The shapefile streams.shp shows major streams in the area. Task 1 covers terrain mapping and analysis using Spatial Analyst and 3-D Analyst in ArcView.

1.1 Create a contour theme


1.
Start ArcView and load both 3-D Analyst and Spatial Analyst.


2.
Open a new view, and add the grid data source, plne, and the shapefile, streams.shp, to view. Click the check box for plne to display the elevation grid. Make plne active.


3.
Select Create Contours from the Surface menu. Enter 100 as the contour interval and 800 as the base contour. Elevations in plne range from 743 to 1986 meters.


4.
Draw the newly created contour theme.

1.2 Create a vertical profile


1.
Activate streams.shp, and open its theme table. Use the Query Builder to select ‘usgh_id = 167,’ a small tributary to be used for plotting a vertical profile. Because the selected tributary is a planimetric feature, elevation changes along the tributary must be derived from an elevation grid. 


2.
Select Convert to 3-D Shapefile from the Theme menu. Select Surface to get Z values from, and plne as the surface. In the following dialog, set 30 meters as the sample distance on grid and name the 3-D shapefile as profile.shp. The sample distance of 30 meters is the same as the cell size of plne.


3.
Activate profile.shp.


4.
Open a new layout, and then click on the Profile Graph tool. Define the area within the layout to draw the vertical profile. Press the cursor at the upper left corner of the intended area and drag the cursor to the lower right, while holding down the mouse button. Release the mouse button.


5.
In the Profile Graph Properties dialog, set the vertical exaggeration factor to 10. Click OK. The layout shows the vertical profile of the selected stream.

1.3 Create a hillshade theme


1.
Activate plne, and select Compute Hillshade from the Surface menu. Take the default values of 315 as the azimuth and 45 as the altitude. In other words, the light source for creating the hillshade theme comes from the northwest, at an angle of 450 above the horizon. Click OK.


2.
Draw the hill shade theme.

1.4 Create a perspective view


1.
ArcView manages 3-D perspective views via the 3-D-Scenes document, which is added by 3-D Analyst. Select the 3-D-Scenes document and double click on the New button. A separate Table of Contents and a 3-D viewer are now opened.


2.
Select Add Theme from the 3-D Scene menu. Add the elevation grid plne to view. The initial view of plne is 2-D. To change it to a 3-D view, select 3-D Properties from the Theme menu. In the 3-D Theme Properties dialog, check Surface and click OK. The 3-D view has a (1) scale of 1, that is, with no vertical exaggeration. 


3.
The 3-D viewer has a set of tools that allow you to manipulate the 3-D view. The Navigate tool lets you view the surface from different viewing directions and distances. The Rotate Viewer tool automatically rotates the 3-D view in a counterclockwise direction. You can stop the rotation by clicking on the Stop button. You also have tools to zoom in or zoom out, or to identify or select features. 


4.
Next, you want to drape streams on the 3-D view. Select Add Theme from the 3-D Scene menu, and select the feature theme streams.shp. Because streams.shp is a 2-D theme, you must convert it to a 3-D shapefile. Activate streams.shp and select Convert to 3-D Shapefile from the Theme menu. In the following dialog, select Surface to get z values from, plne as the surface, and 30 meters as the sample distance. Then, name the new shapefile as strm3d.shp. Display strm3d.shp and streams are draped on the 3-D surface.


5.
You can work with the View document alongside the 3-D-Scenes document. For example, you can create a hill shade of plne and display it in 3-D view. 

1.5 Create a slope theme


1.
Activate plne, and select Derive Slope from the Surface menu to create a slope theme from plne. Display the slope theme by clicking on its check box.


2.
The slope theme is a floating-point grid. The default classification divides slope values (in degrees) into nine equal-interval classes. You want to use a legend with meaningful class breaks. Select Reclassify from the Analysis menu. Click on the Classify button. Change the number of classes to 5, and click OK. In the Reclassify Values dialog, change Old Values to 0–10, 10–20, 20–30, 30–40, and 40–55 respectively and click OK. The new theme, Reclass of Slope, classifies slope values with a 10-degree interval. Draw the new theme. 


3.
Reclassify not only changes the classification but also converts the slope theme from a floating-point grid to an integer grid. One advantage of having an integer grid is that you can display its attribute data. Select Table from the Theme menu to display the attributes of value and count of Reclass of Slope. Value represents the re-classed slope value: 1 for 0–100, 2 for 10–200, and so on. Count shows the number of cells in each slope category. You can derive the area percentage of a slope category by dividing its count by the total count.

1.6 Create an aspect theme 


1.
Activate plne, and select Derive Aspect from the Surface menu to create an aspect theme. The aspect theme is displayed in nine categories: flat, north, northeast, east, southeast, south, southwest, west, and northwest. But the aspect grid is actually a floating-point grid and does not have a theme table. Use Reclassify in the Analysis menu to convert the aspect grid to an integer grid or to change the aspect classification, for example, from the eight to four principal directions. 


2.
To convert the aspect grid to an integer grid but still keep the eight principal directions, use the following table in the Reclassify Values dialog:

Old Values
-1
 0–22.5  
22.5–67.5   
67.5–112.5   112.5–157.5

New Values
-1
1
      2
              3
                    4


 Old Values  
157.5–202.5   202.5–247.5  
247.5–292.5   292.5–337.5   337.5–360

New Values

5
                  6       
7
           8
            1



The north aspect is made of two components in the table: 0–22.5˚ and 337.5–360˚. Flat areas have a value of 21. As with slope classes, you can derive the area percentage of different aspects by opening the attribute table of the Reclass of Aspect theme.


3.
To convert the aspect grid to an integer grid and from the eight to four principal directions, use the following table in the Reclassify Values dialog:

Old Values
-1
0–45
45–135
135–225
225–315
315–360

New Values
-1
1
2
3
4
1

The reclassification groups the study area into flat areas and four principal aspects (north, east, south, and west). The north aspect consists of two sectors: one from 0˚ to 45˚, and the other from 315˚ to 360˚. 

Task 2. Viewshed Analysis

What you need: plne, an elevation grid; and lookouts.shp, a lookout location shapefile.


The elevation grid plne is the same as for Task 1. The lookout location theme contains two points, labeled 1 and 2. A viewshed analysis determines areas in plne that are visible from the two lookout locations and areas that are not visible. 


1.
Start ArcView and load Spatial Analyst. Open a new view, and add plne and lookouts.shp to view.


2.
Activate lookouts.shp. To label the two lookout locations, select Auto-label from the Theme menu. In the Auto-label dialog, select Id for the Label Field and click OK.


3.
Activate both lookouts.shp and plne, because the viewshed analysis requires both themes. Select Calculate Viewshed from the Surface menu. 


4.
Draw the Visibility of Lookouts.shp theme. The study area is categorized as either visible or not visible. Activate the visibility theme and open its theme table. The first record in the table shows the count of cells not visible from the lookout points. The second record shows the count of cells visible from one lookout point, and the third record the count of cells visible from two lookout points. 

You can also create your own lookout shapefile for viewshed analysis by creating a new theme and by adding point(s) to the theme. The following shows you how to create a lookout shapefile:


1.
Select New Theme from the View menu, and Point for the Feature Type. Name the new theme newpoints.shp and save it. 


2.
Click on the Draw Point tool. Click two or more points as your choices for the lookout locations. To exit from drawing points, click the Select Graphics tool and click anywhere outside the study area in view. Select Stop Editing from the Theme menu and save the changes.


3.
This step is to label the ID of the lookout location. Make newpoints.shp active. Select Table from the Theme menu to open the table for newpoints.shp. Select Starting Editing from the Table menu. Click ID to make it active. Click on the Edit tool. Click the first cell under ID, and enter an ID value of 1. Repeat this procedure for entering ID’s of other cells. 


4.
Select Stop Editing from the Table menu, and save the edits. Your own lookout shapefile is now ready to be used in a viewshed analysis.

Task 3. Build and Display TIN in ArcView 

What you need: emidalat, an elevation grid; and emidastrm.shp, a stream shapefile.


Task 3 shows you how to construct a TIN from an elevation grid and to modify the TIN with emidastrm.shp as breaklines. You will also display the TIN with elevation, slope, and aspect data.


1.
Start ArcView and load 3-D Analyst and Spatial Analyst. Add emidalat and emidastrm.shp to view. 


2.
The first part of the task is to construct a TIN from emidalat. Make emidalat active. Select Convert Grid to TIN from the Theme menu. Name the output TIN emidatin. Enter 10 (meters) as the z-value tolerance. As explained in the chapter, 3-D Analyst uses the maximum z-tolerance to make a TIN. The input value of 10 meters means that the TIN cannot differ in height by more than 10 meters from emidalat at any cell location. 


3.
Next, use emidastrm.shp to modify emidatin. Activate emidatin. Select Starting Editing from the Theme menu. The check box next to emidatin in the Table of Contents changes to dashed lines, meaning that emidatin is ready for modification. Activate emidastrm.shp. Select Add Features to TIN from the Surface menu. In the Create new TIN dialog, choose Spot for the Height Source, and Hard Breaklines for the Input. Hard breaklines provide edges of new triangles for reconstructing the TIN. Click OK. You have modified emidatin. Activate emidatin. Select Stop Editing from the Theme menu, and save edits to emidatin.


4.
Now you can view emidatin in several ways. Open emidatin’s legend editor. In the Legend Editor dialog, check the box next to Points and turn off Lines and Faces. The Points legend type includes Single Symbol and Elevation Range. Try Single Symbol first and click Apply. The point symbols show the nodes of emidatin. Notice more points are located along streams and in hilly areas. Next try Elevation Range. The point symbols are color coded by elevation range.


5.
To see triangles in emidatin, turn on Lines with the Single Symbol legend and turn off Points and Faces. Click Apply.


6.
The legend type for Faces includes Single Symbol, Elevation Range, Slope, and Aspect. Faces refer to triangular facets in emidatin. The legend type allows you to display emidatin with symbols representing elevation ranges, slopes, or aspects.


7.
You can also query triangles in emidatin. Change the Lines legend type to Single Symbol and the Faces legend type to Elevation Range. Click Apply. Then zoom into a small area so that you can clearly see the triangles. Press the Identify tool. Click several points within a triangle. You should see in the Identify Results dialog that the slope and aspect values are constant, but that the elevation values change each time you click a new point. 


8.
The last part of this task is to view emidatin as a 3-D scene. Click 3-D Scenes in ArcView’s Table of Contents, and open a new 3-D Scene Viewer. Add emidatin as a new theme to view. You should see a 3-D view of emidatin. Notice the 3-D view of emidatin is clear and sharp because of the triangular facets. Use the tools of the 3-D Viewer to rotate or pan emidatin. You can also zoom in and zoom out. The legend editor for the 3-D scene of emidatin is the same as in regular view. Therefore, you can change the display of emidatin by changing the legend types for points, lines, and faces.

Task 4. Build and Analyze TIN in ARC/INFO

What you need: emidalat, an elevation grid; and breakstrm, a stream coverage.


Like Task 3, Task 4 uses emidalat and breakstrm to create a TIN and to derive slope and aspect from the TIN. But for Task 4, you will build the TIN in ARC/INFO using the VIP algorithm and derive slope and aspect maps from the TIN as polygon coverages. 


1.
The VIP algorithm selects “very important” points from an elevation grid to be included in a TIN. ARC/INFO allows users to specify a percentage of elevation points to be selected. The default is 10%.



Arc: vip emidalat emidavip /*emidavip is the output point coverage


2.
The CREATETIN command in ARC/INFO can create a TIN using data from different sources. For this task, you will use two data sources: (1) elevation points selected by the VIP algorithm and (2) the hard breakline of emidastrm. Elevation along streams in emidastrm will be derived from the elevation grid emidalat. CREATETIN is a dialog command. You will use subcommands in the dialog to enter the input data.



Arc: createtin emidatin2 /* emidatin2 is the output tin



: cover emidavip point /* input elevation points from emidavip


: lattice emidalat breakstrm line hardline /* input emidastrm as hardline



:end /* exit createtin


3.
The next step converts emidatin2 to a polygon coverage. Each triangle in emidatin2 becomes a polygon with its slope and aspect measures. Slopes can be measured in percent or degree.



Arc: tinarc emidatin2 emidapoly poly percent /*emidapoly is the polygon coverage


4.
Emidapoly contains the items of percent slope and aspect. Typically, percent slope values are grouped into classes so that slopecode 1 = 0–20%, slopecode 2 = 20–40%, and so on. After the slope classification is completed, emidapoly can be dissolved into a slope (polygon) map by using slopecode as the dissolve item. Likewise, emidapoly can be dissolved into an aspect (polygon) map by using aspectcode as the dissolve item. The following shows the command to dissolve emidapoly into a slope map called emidaslope:



Arc: dissolve emidapoly emidaslope slopecode poly

